
 
520 6th Street 

Madison, AL  35756 USA   
   

 

12/13/2024 

12/13/2024 
Revision 1.0.2 

 

 

 

LP360 Land Users Guide 

 

 

 

 

 

 

 

 

 

Version 2024.2.107.0 

  



LP360 Land Users Guide 
 

2     LP360 Land v2024.2.107.0   12/13/2024 
 

CONTENTS 

About mdGroup ...................................................................................................................................... 4 

About GeoCue .................................................................................................................................... 4 

About CHC Navigation ............................................................................................................................ 4 

About LP360 LAND ................................................................................................................................. 5 

About LP360 Online ................................................................................................................................ 6 

About LP360 Cloud ............................................................................................................................. 6 

Accessing and Managing LP360 Online from a Web Browser .............................................................. 6 

A Cycle .................................................................................................................................................... 8 

Licensing and Installation........................................................................................................................ 9 

System Requirements ......................................................................................................................... 9 

Installing LP360 LAND ...................................................................................................................... 10 

Perpetual Users ............................................................................................................................. 10 

Subscription Users and TrueView Rentals ..................................................................................... 10 

Perpetual Licensing for LP360 Land .................................................................................................. 10 

Subscription Licensing for LP360 Land .............................................................................................. 12 

StartUp Dialog .................................................................................................................................. 14 

LP360 Online Login in LP360 LAND .................................................................................................. 15 

Updating LP360 LAND .......................................................................................................................17 

Creating A New LAND Project .............................................................................................................. 18 

Raw Mission Import Wizard ............................................................................................................... 19 

Import Mode ................................................................................................................................. 19 

Input Trueview go cycles ........................................................................................................... 19 

Setting TrueView Project, Coordinate Reference System and Epoch ............................................ 22 

Examining Imported Files .................................................................................................................. 23 

Single Cycle Mode ..................................................................................................................... 25 

TrueView GO Processing Workflow ...................................................................................................... 27 

Trueview go point cloud generation .................................................................................................. 27 

Job manager ................................................................................................................................. 27 

Creating Flight Lines and TrueView Trajectories ............................................................................... 28 

Manually Create Flight Lines ......................................................................................................... 28 



LP360 Land Users Guide 
 

3     LP360 Land v2024.2.107.0   12/13/2024 
 

Post Processing ................................................................................................................................. 30 

Difference between post processing las and job manager las ........................................................ 32 

Registration tools .............................................................................................................................. 32 

LAS to LAS Manual Registration ................................................................................................... 33 

Good practices .......................................................................................................................... 36 

LAS to LAS Auto registration ........................................................................................................ 36 

Prerequisites ............................................................................................................................. 36 

How to use it ............................................................................................................................. 36 

Advance settings ....................................................................................................................... 37 

Good practices .......................................................................................................................... 38 

difference between manual and automatic registration ............................................................ 38 

LAS to control registration ............................................................................................................ 38 

Survey Nail Manager ............................................................................................................................. 42 

Control Points Processing (TVGCPs) ..................................................................................................... 44 

Job Manager ......................................................................................................................................... 45 

Submitting Jobs to the Job Manager ................................................................................................. 45 

Monitoring the Job Manager ............................................................................................................. 45 

Export Photo Package .......................................................................................................................... 47 

Explorer Package .................................................................................................................................. 49 

Export/Publish Explorer Package ...................................................................................................... 49 

Open an LP360 Explorer Package...................................................................................................... 50 

Multi-Cycle Processing Tips .................................................................................................................. 52 

Support ................................................................................................................................................. 56 

 

 



LP360 Land Users Guide 
 

4     LP360 Land v2024.2.107.0   12/13/2024 
 

ABOUT MDGROUP 

mdGroup is an aerial digital twin maker for industrial applications. It operates its digital twin making 
business through its portfolio companies Microdrones and GeoCue.  
 
To learn more about mdGroup, visit www.group-md.com 

ABOUT GEOCUE 

GeoCue is a U.S. based LiDAR data technology company offering software, hardware, training, support 
and consulting services for high accuracy LiDAR and imaging drone mapping to help civil engineering 
and surveying professionals achieve successful data collection, processing, and management. 

With its TrueView drone LiDAR/Imaging sensors and LP360 point cloud data processing software, 
GeoCue is the leader in LiDAR mapping processing in North America.  

To learn more about GeoCue, visit www.geocue.com 

ABOUT CHC NAVIGATION 

Founded in 2003, CHC Navigation (Huace:300627.SZ) creates innovative GNSS navigation and 
positioning solutions to make customers' work more efficient. CHCNAV products and solutions cover 
multiple industries such as geospatial, construction, agriculture and marine. 

With a presence across the globe, distributors in more than 120 countries and more than 1,700 
employees, CHC Navigation is today recognized as one of the fastest growing companies in geomatics 
technologies. To learn more, visit chcnav.com. 
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ABOUT LP360 LAND 

LP360 is a 64-bit Windows® desktop application used for many years by the LP360 Geospatial 
community for processing traditional aerial, mobile, and terrestrial tripod laser scanner data. The LP360 
Land community is the focus of this Users Guide containing the LP360 workflows for processing and 
exploiting TrueView and other handheld sensor data. LP360 Land is GeoCue’s LP360 point cloud 
exploitation product with the addition of a collection of tools and workflows for processing handheld 
data. LP360 Land is the software used to post-process your raw data to generate a 3D LiDAR point 
cloud in LAS format, colorize the point cloud, and geotag the images collected. LP360 also has many 
tools for assessing and processing point cloud data, such as accuracy assessment, automatic and 
manual ground classification, and contour/ surface generation. LP360 Land is available in the following 
licensing levels: 

 LPViewer – A free viewer level of LP360 for viewing a point cloud. 
 LP360 Land – Enables PPK processing for systems, such as the DJI P4P RTK, plus TrueView 

2DIS and 3DIS. This is the next generation ASPSuite Advanced and is equivalent to LP360 
Standard with the addition of the sensor workflow tools and tools for ground classification and 
volumetric computations. It is limited to product areas of no more than 10 km2 of LAS data. 
Available as an annual subscription or a perpetual license. 

 LP360 Land +3D Accuracy – Enables the automatic detection of Accuracy Stars and related 
target types. Available as an annual subscription or a perpetual license. 

 LP360 Land+Photo – Enables local Ortho Mapping. Available as an annual subscription or a 
perpetual license. 

 LP360 Land+Photogrammetry with Agisoft – Enables local Agisoft Ortho Mapping, if you 
have a Metashape license, and Cloud based Agisoft Ortho Mapping (using LP360 Points). 
Available as an annual subscription or a perpetual license. 

 LP360 Land+Cloud Photo 3000 – Enables both the local Ortho Mapping, local Agisoft Ortho 
Mapping processing if you have your own Metashape license, and Cloud based Agisoft Ortho 
Mapping (includes 3000 photos per month, additional photos may be processed using LP360 
Points). Available as an annual subscription license. 

 LP360 Land+Strip Align – Enables Strip Align and Strip Adjustment tools for adjusting for 
dynamic trajectory errors in the dataset. Available as an annual subscription or a perpetual 
license. 

 LP360 Land+Business Intelligence Tools – Enables specific point cloud tasks designed for 
extraction of non-ground features, such as rail, power lines, buildings, trees. Available as an 
annual subscription or a perpetual license. 

 LP360 Land+Unlimited – this is the same functionally as LP360 Land with the size limit 
removed. Available as an annual subscription or a perpetual license. 

 LP360 Land+Experimental – this is the same functionality as LP360 Land with the addition of 
features classed as experimental. We may occasionally have features that we call experimental 
where we have limited access available only to those organizations specifically working with us 
on those features. Or, at times, a pre-release version being used for training. 
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ABOUT LP360 ONLINE 

LP360 Online is an Amazon Web Services (AWS) hosted platform that is used for a variety of purposes 
in TrueView (and other) workflows. It provides services such as (items marked with a $T are extra cost, 
paid in Points): 

 Project data hosting and visualization ($T) 
 Data archival ($T) 
 Management and automatic delivery of sensor calibration files 
 Automatic sensor health check 
 Transfer of sensor Cycle data to GeoCue for technical support 
 Management of Points for services that are paid via a metering scheme (marked in this list with 

$T) 
 Transaction history of sensor usage 
 other related services  

LP360 Online is accessed from within LP360 Land in various workflows. These workflows might require 
an LP360 Land user to provide their login credentials. LP360 Online has a web interface for data 
visualization, processing, and account monitoring. 

Every customer is provided an LP360 Online account.  

ABOUT LP360 CLOUD 

LP360 Cloud is an ever-growing collection of cloud-based tools and resources that will make it easy for 
you to manage, archive, share and collaborate on geospatial projects.  

LP360 has four LP360 Cloud Addon products that are subscription licenses. The LP360 Cloud Access 
license is required to use all additional cloud add-on licenses: 

 LP360 Cloud Access → Storing and sharing data 
 LP360 Cloud Starter → Power Search, streaming, and cloud data processing. 
 DJI L1/L2 Cloud Batch Processing → DJI L1/L2 raw data processing 
 Automatic Cloud Ground Classification → Automatic and AI ground classification 

See the LP360 website for the latest that LP360 Cloud has to offer and activate or renew your 
subscription today in the LP360 Portal. 

Note: These license types are not included in the Desktop License. Access will need to be granted to 
each user within the LP360 Portal. For information on how to assign Cloud Licenses, please see LP360 
Portal License Management > Cloud License Management. 

ACCESSING AND MANAGING LP360 ONLINE FROM A WEB BROWSER 

LP360 Online, is the infrastructure for LP360 Points and online data storage via LP360 Cloud. LP360 
Online allows your account admin to add users who can use your account’s LP360 Points and licenses 
for processing.  
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1. If you did not create your online account when making your first subscription license purchase 
then GeoCue will create your account’s LP360 Online account, which you can access at the 
URLs: 

LP360 Portal for user, subscription license and LP360 points management: 
https://portal.lp360.com/ 
LP360 Cloud for data storage, archiving, sharing, and streaming: 
https://cloud.lp360.com/  

2. GeoCue will assign someone from your account as the point of contact. This person will be the 
store administrator of your LP360 Cloud account and may invite additional users who are 
allowed to process. The point of contact will receive an email after purchase which contains the 
invitation to create login credentials.  

3. Additional users may be added at any time by your LP360 Portal Admin. 
4. An invitation email is sent to new user(s) by the LP360 Portal. 

a. The user selects the Setup Account link in the LP360 Invitation e-mail to confirm the e-
mail and create a password. 

b. The password can be reset by the user by accessing one of the LP360 Online URLs and 
using the “Forgot Password?” link on the login page. Note: The password reset will only 
work if the user has previously confirmed their e-mail address within the specified 
timeframe in the LP360 Invitation e-mail. Contact support to have your invitation e-
mail re-sent. 
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A CYCLE 

All TrueView sensors, write their various data streams to a standard file folder structure called a “Cycle” 
on the USB drive or internal memory. The term cycle refers to a sensor power cycle because TrueView 
datasets are started and terminated by the sensor power cycles. It is possible to have multiple 
collections (flights, in the case of a drone) in a single Cycle, so it is not necessarily correct to think of 
Cycle as being synonymous with flight, though it is typically. 
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LICENSING AND INSTALLATION 

SYSTEM REQUIREMENTS 

Recommended systems for LP360 Land Processing: 

 Windows Version 10, Professional (64-bit) or Windows 11 Professional, or their server 
equivalents. 

 i7 or equivalent CPU.  The more cores, the faster the processing. 

 16 GB RAM (32 GB recommended). 

 Nvidia Graphics recommended but not required. 

 Graphics must support Open GL 4.5. 

 Internal Solid State Disk (SSD) with a minimum capacity of 256 GB. 

 Secondary storage recommended but not required (e.g., 2 TB spinning disk). 

 USB 3.0 Required for data transfer from the TrueView USB Mass Storage (TrueView USB 
memory stick). 

 High speed network access required for TrueView Cloud processing (cloud processing of the 
trajectory is the only mode supported for rental systems). 

 A minimum 1920 x 1080 resolution display recommended. High resolution, 4k displays, require 
configuring LP360 Land shortcut properties per Microsoft’s recommendations. 

 Dual Display is highly recommended for office setups. 
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INSTALLING LP360 LAND  

When your TrueView system or LP360 Land is purchased, or a rental or subscription is to begin, your 
account’s point of contact will receive an email from support with instructions for downloading the 
latest version of LP360 Land  from the LP360 Portal, or from the LP360 Installers page on our 
searchable support knowledge base. For perpetual licenses, a username, password, and link for your 
LP360 Online account should be provided in the email, along with your perpetual License String. For 
subscription licenses and licenses provided with a TrueView rental, the first time your organization 
rents or uses LP360, you will receive an invitation to confirm your e-mail address and create a password 
to access the LP360 Portal to download LP360 and to also use as your license credentials.  

PERPETUAL USERS 

Download the latest version of LP360 Land from the LP360 Portal or the LP360 Installers page on our 
searchable support knowledge base and copy to a local drive on your computer. Double-click on the 
installation file to install LP360 Land. Once installed, use the steps below to activate LP360 Land using 
the License String provided in your licensing email. 

Note: It is necessary to enable outbound communications to TCP ports 5053, and the customer specific 
port outlined in your licensing email, on any firewalls for the product to communicate with the hosted 
license server. These ports are normally open by default on most firewalls.  

SUBSCRIPTION USERS AND TRUEVIEW RENTALS 

Download the latest version of LP360 Land from the LP360 Portal and save to a local drive on your 
computer. Double-click on the installation file to install LP360 Land. Once installed, use the steps below 
to activate LP360 Land using a login and password. 

PERPETUAL LICENSING FOR LP360 LAND  

1. Open LP360 Land and select License Manager from the Startup dialog, or File -> License 
Manager 

a. If your version of LP360 Land is currently unlicensed, you will get an error and be 
prompted to open License Manager when you try to open it. 

2. On the Activation tab, under Credentials, select Perpetual, then copy and paste the License 
String, which includes a password, into the License String field. 

3. Select “Set” to set the License String. Once successfully set there is no need to set the License 
String again. 

a. If you encounter an Invalid License String Error message, see the probable resolutions 
on our searchable support knowledge base. 

4. The Available Licenses portion of the license manager should now be highlighted. Select the 
dropdown to select the LP360 Land license. 

5. Select Check out floating license to use your floating license. An Internet connection must be 
maintained while using a floating license. 
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a. If you need to use the license without internet connectivity, check the box to roam the 
license, and then check out the license. A license can be roamed for up to 30 days. 
Other users with access to this license will not be able to use it while the license is 
roamed. 

6. The Current License portion of the dialog should now show the license type with a green 
checkmark (Figure 1) indicating that the license has been activated. 

  

Figure 1 - License Manager 

7. The license is now activated, and LP360 Land can be used for processing. 
8. If applicable, select additional addon products from the Available Products list and select 

“Check Out License” to enable the addon license in addition to the base LP360 Land license. 
9. Select Close to close the LP360 Land Manager and open LP360 Land at the desired license 

level. 
10. You can reopen the LP360 Land License Manager at any time from within LP360 Land (File -> 

License Manager) to change license levels. 
11. Repeat this process for all desired machines.  

The LP360 Land license comes standard as a floating license, which means the license can be shared 
easily within your organization. Just install LP360 Land on all the machines that need to use the 
software, then repeat steps 1-6. Only one machine can use the license for one instance of LP360 Land 
at a time. The license can be checked in and out as needed if it is not in use by another machine. 

 Feature Level  LP360  LP360 Drone  LP360 Land 
Visualization  Viewer (V)  Explorer (X)  Viewer (V) 
PPK processing   Drone (D)  
TVGO processing   Land Basic 
Registration tools Advanced BIT addon Land Standard 
Auto detect 2D and 
3D targets in the 
Control Report 

Advanced 3D Accuracy addon 3D Accuracy addon 

Creating Products  Basic   Land Standard 
Interactive Edit  Standard   Land Standard 
Automated 
Extraction, 
TrueView 3DIS® 
Post-Processing 
(Drone Only)  

Drone (D)1, 
Advanced  

BIT addon BIT addon 
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 Feature Level  LP360  LP360 Drone  LP360 Land 
Removes 10 km2 
size restriction 

 Unlimited addon Unlimited addon 

Experimental Advanced Experimental 
addon 

Experimental 
addon 

Table 1 - Licensing Levels of LP360 

SUBSCRIPTION LICENSING FOR LP360 LAND  

1. Open LP360 Land and select License Manager from the Startup dialog, or File -> License 
Manager 

a. If your version of LP360 Land is currently unlicensed, you will get an error and be 
prompted to open License Manager when you try to open it. 

2. On the Activation tab, under Credentials, select Subscription, then enter the same credentials 
you created when completing your invitation to the LP360 Portal to access the licenses for your 
organization. 

3. The Available Licenses portion of the license manager should now be highlighted. Select the 
dropdown to select the LP360 Land license. 

4. Select Check out floating license to use your floating license. An Internet connection must be 
maintained while using a floating license. 

a. If you need to use the license without an internet connection, check the box to roam 
the license, and then check out the license. A license can be roamed for up to 30 days. 
Other users with access to this license will not be able to use it while the license is 
roamed, and a roamed license will not be automatically checked in when the LP360 
session is closed. 

5. The Current License portion of the dialog should now show the license type with a green 
checkmark (Figure 1) indicating that the license has been activated. 

 

Figure 2 - License Manager 

6. The license is now activated, and LP360 Land can be used for processing.  
7. If applicable, select additional addon products from the Available Products list and select 

“Check Out License” to enable the addon license in addition to the base LP360 Land license. 
8. Select Close to close the LP360 Land License Manager and open LP360 Land at the desired 

license level. 
9. You can reopen the LP360 Land License Manager at any time from within LP360 Land (File -> 

License Manager) to change license levels. 
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10. Repeat this process for all desired machines.  
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STARTUP DIALOG  

Upon launching LP360 Land, you will be presented with the LP360 Startup dialog containing the 
frequent starting places. 

 

Figure 3 - Startup dialog 

 Add Files to Map – The typical starting place for geospatial users to start a project by adding 
LAS, Raster, Feature files, etc. to the session.  

 Open Existing Project – Launches Project Manager and presents the list of previously opened 
projects, defaulting to the last opened project. 

 Create a New Project – Opens the Create Project dialog for when you wish to create a new 
project from existing LAS/Raster/Feature/True Pose Photo data instead of a Cycle. Not typical 
for a TrueView workflow as a new project is created when importing the first Cycle into a NEW 
project. 

 Import Raw Mission into New Project – Opens the Raw Mission Import Wizard to walk you 
through creating a new project while importing raw mission (Cycle/Flight) data from a 
TrueView, microdrones, other supported sensor, or sensor trajectory and LAS from any sensor 
into LP360. 

 Import LP360 Explorer Package – Opens the Import Explorer Package dialog to create a new 
project from an Explorer Package. This is the starting place for the LP360 Explorer license user 
who has received an Explorer Package from a TrueView sensor owner. 

 License Manager – Invoke the License Manager dialog to license or change the desired license 
level. Upon closing the License Manager dialog, returns to the Startup dialog. 

Note: Cancelling the Startup dialog will bring you into a blank session of LP360 Land. 
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LP360 ONLINE LOGIN IN LP360 LAND 

LP360 Online is used for a variety of purposes in TrueView workflows. To facilitate, the settings use a 
universal online login in the upper right of the LP360 Land main frame (Figure 4). For perpetual licenses, 
this login is separate from your license credentials, but are the same credentials for subscription users 
with LP360 Online. Users with LP360 Online licenses are automatically logged into LP360 Online and 
will not see the Online Account Sign in dialog when selecting on the [Sign In] button. LP360 Online 
subscription license users do not have a log out option. 

 

Figure 4 - Unified Online Login 

The login string shows information about the login in the following format:  

email of logged in user (Account) [Point balance]  

To sign in or change online accounts, the user left clicks on the login bar, opening the Online Account 
Sign In dialog (Figure 5).  

For LP360 Online, the user should be automatically signed when using subscription license 
credentials. 

TrueView Reckon has been deprecated. DO NOT USE. Please use your LP360 Online account.  

 

Figure 5 – Online Account Sign In dialog 
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Note: It is not necessary to sign into your online account if you are not going to do any online 
related processing, but there are more functions being added to LP360 that utilize LP360 
Online as time goes on. 
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UPDATING LP360 LAND  

Users already running LP360 Land v2024.2 or later may update LP360 Land by the prompt they will see 
when starting LP360 Land, or by selecting Help -> Check for Updates in the LP360 Land dialog. The 
latest version of LP360 Land may also be downloaded from the LP360 Portal or from the LP360 
Installers page on our searchable support knowledge base and installed over the older version. 

Release – The default and recommended selection is to automatically download and install the latest 
LP360 Land release. 

Patch – Installs small patches for defect fixes and changes without needing to perform an entire service 
pack installation. 

Service Pack – A roll up of the available patches into a complete installer that includes the full release 
installer. 

Experimental – Access to the experimental version is granted based on the organization and uses the 
LP360 Online login. We may occasionally have products or features that we call experimental where we 
have a limited version available only to those accounts specifically working with us on those features or 
products. Or, at times, a pre-release version being used for training and available from the TrueView 
Training account. 

 

Figure 6 - Check for Updates 
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CREATING A NEW LAND PROJECT 

The following steps will guide you through each step of the workflow, importing data to create a land 
project, generating a LiDAR point cloud, tagging photos, or performing registration. Importing a Cycle 
is the first step, post data acquisition, of the Sensor workflow. A Cycle can be imported into LP360 Land 
to form a new project or, if a project already exists, to add a Cycle to that project.  

1. Open LP360 Land and check out your license if necessary. See the Licensing LP360 Land 
section in this document. 

2. Insert the USB drive, which contains your Cycles/Flights (raw flight data), into your computer. 

3. Select Cycle Import  on the Sensor tab (Figure 7) to open the Raw Mission Import Wizard. If 
the wizard is run outside of an existing LP360 project, then it will create a new project. If you run 
the wizard from within an existing project, the occurrences of “NEW” in Figure 8 are replaced 
with “CURRENT”. 

Note: If the Cycle Import button is greyed out, then you do not have a valid LP360 Land license 
checked out. See the Licensing LP360 Land section in this document. 

 

Figure 7 – Import Cycle 
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RAW MISSION IMPORT WIZARD 

Selecting Cycle Import  on the Sensor tab brings up the first page of the Raw Mission Import wizard 
(Figure 8). 

 

Figure 8 - First page of Import Cycle Wizard for a NEW Project 

An alternative way to enter to the Raw Mission Import Wizard is via the “LP360 Startup” onboarding 
window. 

1. Select “Import Raw Mission into New Project…” 

 

Figure 9: Startup window 

IMPORT MODE 

The import mode options allow you to import a Cycle. Import Flights into NEW/CURRENT Project – 
this option imports a Cycle into an existing or new project. 

INPUT TRUEVIEW GO CYCLES 

Step by step how to process a TrueView GO (TVGO) handheld mapping dataset in LP360. 

1. Select “Import Raw Missions into New Project…” 
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2. Select “TrueView GO”. 

3. Press “Folder” to import the raw data from the sensor. You can select 1 or more cycles 
(datasets) to be process in the same project. 
Note: the very first time you select TVGO data the software will ask you to install the LP360 
sensor extension. 

 

Figure 10: Import wizard TVGO 

5. Settings  , the TrueView Go Advanced Settings provides extra settings to the TVGO 
processing 

                                       

                                                                   Figure 11: TVGO Advance Settings 

1. Colorization Method: this setting controls the colorization type required 

1. None: generates a non-colorized point cloud 

2. Fast: Recommended colorization point cloud 

3. High Precision: Highly intensive colorization that preserves better the real 
features colours. However, it is time consuming. 
Note: This setting requires a NVIDIA graphics card. It is recommended a 3050Ti 
series and above GPU, Intel Corei7 and above CPU. 
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2. Scene Type: this setting helps the algorithm to improve the 3D reconstruction 

1. Indoor (No GNSS): Recommended for Indoor areas. It will be automatically 
selected if the user selects “SLAM” mode. 

2. Outdoor (GNSS): Recommended for Outdoor areas with GNSS reception. It will 
be automatically selected if the user selects “RTK” or “PPK” mode. 

3. Mixed Indoor and Outdoor: Recommended for projects with areas outdoor and 
indoor, in this type of projects most of the work is done outside with GNSS 
reception, however there will be small areas surveyed indoor without GNSS 
reception. 

3. Moving Objects Filter: Filter that will try to clean moving objects from the point cloud. 

4. Apply Settings to All Cycles: Select this option to apply the same settings selected to all 
the cycles. 

6. Now, select the processing mode in the "Mode" column. There are 3 different types:  

1. SLAM--> dataset acquired in a local coordinate system 

2. RTK --> dataset georeferenced with a global coordinate system. The user needs to 
select the RTK Geographic CRS. The most common geographic CRS are: "WGS84 + 
Ellipsoidal" (world), "NAD83(2011) + Ellipsoidal" (CONUS) and "ETRS89 + Ellipsoidal" 
(Europe). 

3. PPK --> dataset georeferenced with a global coordinate system, it requires a base 
station. The user needs to select a RINEX file and the coordinates of the base station. 

 

Figure 12: PPK processing TVGO 

7. Press Next. 

8. Select the Project Root Folder and the Project Name. 

9. Select the desired CRS. 
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Figure 13: Project Root and CRS selection 

Tip: Select "Local Coordinate system" for SLAM datasets 

10. Press Next –> The summary will be display –> Press next. 

11. Data imported. 

 

SETTING TRUEVIEW PROJECT, COORDINATE REFERENCE SYSTEM AND EPOCH 

If creating a new TrueView Project during the import (i.e., you are not running this wizard from within 
an existing TrueView Project), you will be presented the dialog of Figure 13. Browse to the top-level 
folder where you would like the TrueView Project folder to be created. There is a Default Projects Root 
Folder setting on the File -> Project Settings -> Project tab if you would always like your projects 
created in the same location (recommended). Under the “TrueView Output Project Name”, type in the 
name of your new project. You will receive an error message if a Project of that name already exists in 
the selected project folder. If this occurs, choose a different project name (or location). 

If running the Wizard from within an existing TrueView Project, the Cycle being imported will be added 
to this project (which, of course, is already named), hence the import Wizard will skip this step. 

In the lower section of the dialog, set the Coordinate Reference System (CRS) that will be used for the 

project by selecting from the Recent Coordinate Reference System list or by selecting the  to 
open the Select Project Coordinate Reference System dialog (Figure 14). Remove an item from the 

Most Recent Used list by selecting the item to delete and pressing the  tool. The suggested UTM 
zone is provided to assist users processing to UTM, but unsure of in which zone the data resides. 
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Note: If adding a Cycle/Flight to an existing project, this section of the dialog will show the current 
project CRS but will not allow you to change it (you can change a project CRS via other LP360 
tools). 

 

Figure 14 - Select Project Coordinate Reference System 

The project epoch is set when the project CRS is selected if one is known for the datum of the selected 
project CRS. It can be verified (File -> Project Settings -> Project -> Project Epoch) and modified after 
Import Cycle has completed. Use the decimal year of the Cycle Date for coordinate reference systems 
using variable ellipsoid and variable epoch, such as the WGS84 datum, otherwise select enter the 
applicable epoch for the datum of your coordinate reference system. For example, NAD83(2011) has a 
fixed ellipsoid and variable epoch date of 2010.0. Typically, the epoch date for your project datum 
should be selected by default. 

EXAMINING IMPORTED FILES 

After the import is complete, the trajectory files will be displayed in the map view of LP360 Land. A 
WMS layer will be displayed behind the data so the user can see approximately where flight path 
occurred. The white box on the left side is the Table of Contents (TOC), the map area on the right is 
referred to as the Map View. Each layer in the TOC is named after the Cycle date and time, with a 
name appended to the end that represents the type of information contained in the layer and 
prepended by the Area Name (Area_Name_Cycle_Flight). A layer can be selected by left clicking on 
the desired layer until it is highlighted. Once selected, right-click the layer and select Feature 
Analyst to open the Feature Analyst dialog to review the attributes of features on the layer. 
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Figure 15: TOC and Map View 

a) Trajectory Line Layer – Shows the real-time trajectory from the beginning to the end 
of the Cycle.  

b) Trajectory Points Layer – TrueView Go sensors collect a location point every second 
based on the real-time navigation position information from the Position and 
Orientation System. You can select a Trajectory Point with the info tool to show 
metadata such as location and height in the info pane of the TOC. These points can be 
used to Manually Create Flight Lines.  

c) Retain Photos Layer – This layer contains information about the photos acquired in the 
area of interest, keeping all the True Pose information. These photos are the same as 
the photos contained in the Photo Layer but narrowed to the area of interest. 

d) Photos Layer – This layer contains information about each photo and photos can be 
viewed in Feature Analyst. The icons in the Map View represent the location each photo 
was taken, using the navigation grade solution (real-time) of the TrueView Position and 
Orientation System (POS). If your sensor has multiple cameras, you will see an icon for 
each photo from each camera. Thus, if you zoom in on the display, you will usually see 
photo icons close together. This occurs because TrueView sensors with multiple 
cameras usually fire the cameras at approximately the same time. You can quickly 
inspect information about any feature in LP360 by selecting the Info tool (the “I” icon on 
the main toolbar), left clicking the item you wish to inspect and viewing the attribute 
data in the Info pane of the TOC. This is illustrated for a photo in Figure 17.  

e) WMS Layer – A WMS backdrop layer, such as Google Hybrid or Bing Aerial with Labels, 
allows the user to check the flight for coverage and rough location. 

f) Layer toggle On/Off – Each layer can be toggled on/off and viewed independently by 
toggling the checkbox next to the layer.  

g) Layer in Map – Each layer is plotted on the map view as shown in) in the order they are 
listed, from top to bottom, in the TOC. 



LP360 Land Users Guide 
 

25     LP360 Land v2024.2.107.0   12/13/2024 
 

 

Figure 16 – Feature Analyst 

 

Figure 17 - Inspecting a Feature 

Repeat the TrueView Import Wizard to add more datasets to the same project. After the data has been 
imported and the files have been examined. 

 

SINGLE CYCLE MODE 

Enabling Single Cycle Mode  will display layers relevant to the Active Cycle making for efficient 
review of the layers for each imported Cycle/Mission. The Single Cycle Mode is a shortcut configuration 

for the standard Use mode in Project Manager where, layers are live and you can modify the display 
by changing the layers listed in the Table of Contents. Members of the active Cycle display group are 
configured automatically during Cycle Import but may be modified by using the Groups -> Build mode 

on the Groups/Layers tab of Project Manager . The build mode allows one to set up new groups, edit 
existing groups, and delete groups you no longer need. You can also automatically create groups based 
on unique cycle or temporal data. Use the Refresh button to update the Table of Contents to see any 



LP360 Land Users Guide 
 

26     LP360 Land v2024.2.107.0   12/13/2024 
 

changes you have made. In build mode, select the group to modify on the left, then layers can be 
configured as Visible, Member, Base, and/or ImageExplorer. 

Visible – The layer is enabled in the TOC and visible in the map view when the view group is 
selected when in the Use mode. 

Member – The layer is part of the selected group and displayed on the TOC when the view 
group is selected when in the Use mode. 

Base – Denotes the layer is a base layer, such as a WMS layer. 

Image Explorer – Denotes the layer is suitable for use by Image Explorer. LP360 disables the 
photo layer when it creates the Retained Photos layer to remove the photos in turns and 
takeoff and landing from being displayed in Image Explorer. 

 

Figure 18 - Build Mode in the Groups/Layers tab of Project Manager 
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TRUEVIEW GO PROCESSING WORKFLOW 

This section provides a step-by-step guide to processing TrueView GO data from the point of project 
creation to a colorized point cloud, exporting a photo package for downstream processing, or aligning 
multiple datasets.  

TRUEVIEW GO POINT CLOUD GENERATION 

Once the cycles are imported into LP360, it will automatically start processing the raw data.  

JOB MANAGER 

2. The TrueView GO (TGO) job progress may be monitored using Job Manager .  

 

Figure 19: Job manager with TVGO jobs 

3. Upon completion of the TGO job by the Job Manager : 
1. Job Manager will indicate completion by the green checkmark flashing on the Job 

Manager icon  indicating it is in the Ready state. 
2. The job will need to be completed to add the resulting LAS layer and/or LAS files to the 

open project. 

4. In Job Manager , select the applicable TGO job, then select View Log to review the 
processing log.  

5. In Job Manager , select the applicable TGO job, then select Open Project to open the 
applicable project for the job, if not currently open. 

6. Then, select Complete Job to add the unfiltered point cloud as a new LAS Layer to the 
currently open project. 

7. When desired, in Job Manager , select the applicable TGO job, then select Delete Job to 
clean up the temporary files generated while processing the job. 
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CREATING FLIGHT LINES AND TRUEVIEW TRAJECTORIES 

This step is optional, and only suggested to users who want to crop part of the trajectory. Most of the 
users can skip this step. 

There are 2 modes of cropping the trajectory: 

- Auto create flight lines: this mode is only recommended for user that walked in strait lines, and 
can recognize each acquisition line. Most of the time this tool will not be used. 

- Manual flight lines: this mode is the recommended for TVGO data, the user will select the first 
and last trajectory point, to create the desired trajectory. 

 

Figure 20 – Auto Create Flight Lines 

 

Figure 21 - Create Flight Lines from Selected Trajectory Points 

 

MANUALLY CREATE FLIGHT LINES 

1. Flight lines can be added manually by selecting trajectory points (red points) at the beginning 
and end of each line. 

a) Select the Select/ Edit Features tool   on the LP360 Feature Edit tab (Error! 
Reference source not found.). 

b) Select a trajectory point at the beginning of the desired flight line. The point will be 
highlighted when selected.  

c) Hold control, then select a trajectory point at the end of the flight line. Both trajectory 
points should now be highlighted.  
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Figure 22 – Manually Creating Flight Lines 

d) Select Create Flight Lines from Selected Trajectory Points  on the Sensor tab 
(Figure 21) and a new flight line should be created.  

e) Select the Save Feature Edits  icon on the LP360 Feature Edit tab (Error! Reference 
source not found.)  to save the edits.  

Note: If you select Trajectory Point patterns that do not form the required base for creating a 
flight line, you will receive an error message that explains the issue (Figure 23).   

 

Figure 23 - A pattern of Trajectory Points not compatible with forming a flight line 



LP360 Land Users Guide 
 

30     LP360 Land v2024.2.107.0   12/13/2024 
 

POST PROCESSING 

The Post Processing tool can be used for all TVGO sensor0. The purpose of this tool is to prepare 
datasets for post processing tools. The main need is to use the flight line layer to create a trajectory file 
for each flight line from the sensor trajectory file(s) and cut the LAS data into files corresponding to 
those flight lines, plus, apply any additional user desired filtering while performing this operation. This 
tool is helpful for filtering noise. 

1. Go to Sensor ribbon –> Post Processing tool. 

2. Select the Clip Angle. Tip: Disable the filter for TVGO since we want to use the full 360° FOV of 
the sensor. 

3. Select the filtering and photos. 

 

Figure 24: Post Processing 

- Clip Angle – Enter the processing angle in degrees. This number represents the half angle off 
Nadir of the scanner. If 40 is entered, LiDAR data will be geocoded if it falls between +40° and -
40° creating a total field of view (FOV) of 80° (not recommended for the TVGO). 

- Clip Range – Enter the minimum and maximum range to be geocoded. No points with a range 
less than and/or greater than these values, respectively, will be geocoded. Useful when no Clip 
Angle is used to pick up features beside the system. 

- Promote LAS to Version 1.4 – Default is checked. This ensures the output LAS file format will 
be 1.4.  

- Starting Flight Line Number (Point Source ID) – When there are multiple Cycles or flights in a 
project it is important to assign unique point source IDs, or flight line numbers to each line. 
Selecting a unique starting ID allows the user to determine the best values between 1 and 65535 
to use for each line. For multi-Cycle projects it is suggested to use a nomenclature, such as 
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CCCFF, where CCC is the Cycles flown for the project, 1-645, and FF is the flight line per Cycle, 
1-99, to keep the point source IDs unique within the project. 

- Retained Photos Layer Settings – This section will only become available when a photo layer 
is detected. Allows the user to specify the photos to be kept for geotagging and export to 

photogrammetric software packages using Export Photo Package  or for processing in 

Agisoft Ortho Mapping , or for processing in Ortho Mapping . The notion of “Retained 
Photos” creates a layer of the retained photos on a new layer called “RetainedPhotos.” 

i. Retain Photos within Flight Lines – This option retains only the photos that 
occur between the start and end of each flight line (flight lines were defined in 
the prior Create Flight Lines step). This option eliminates photos in turns. 
(Recommended). Selecting the option to “Retain Photos within Flight Lines.” 
creates a new layer in the Table of Contents (TOC) called “RetainedPhotos”. 
The resultant layer is shown in Error! Reference source not found.. Note that 
only photos that are between the beginning and end of each flight line are 
retained. 

ii. Retain Photos within Flights Lines and Interior Turns – This option retains all 
photos from the start of the first flight line (start as defined by GPS time) and 
the end of the last flight line. Thus, all ferry line photos are retained.  

iii. Retain All Photos – All project photos are retained. 

4. Run Post Processing … 

5. Post processing point cloud is generated. 

 

Figure 25: Point cloud generated from post processing 
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DIFFERENCE BETWEEN POST PROCESSING LAS AND JOB MANAGER LAS 

Both point clouds come from the same raw data, however one has all the data captured from the sensor 
(TGO point cloud) and the other is filtered by the defined "flight lines" and filters of the "Post 
Processing" tool. 

In the following example it is possible to see how the clip range filter has removed long range points 
captured by the sensor. Recall the TVGO has a range of up to 80 meters. 

 

Figure 26: Job manager LAS in grey and PP LAS in green colours 

REGISTRATION TOOLS 

Registration tools are a group of tools that modify the position of a point cloud to align in with a 
reference. The tools perform a rigid registration getting the values from different sources. 

 

Figure 27: Registration tools 
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There are 3 registration tools: 

- LAS to LAS Manual Registration 
- LAS to LAS Auto Registration 
- LAS to Control Registration 

LAS TO LAS MANUAL REGISTRATION 

Manual registration is a tool performing coarse alignment, in other words it performs a rigid 
registration where the user manually aligns multiple LAS. 

Before using LAS to LAS manual registration, make sure to have at least 2-point clouds, and identify 
each point cloud. One will be used as a reference and the other will be registered. 

1. Open LAS to LAS Manual Registration tool. 
2. Select the "Reference LAS Layer" 
3. Select the "Registered LAS Layer" 
4. Press "Pick A New Pair" 

                             

Figure 28: LAS to LAS Registration 

 
5. Select one pair of common point in both point clouds 
6. Measure a common point in the "Registered" point cloud. 
7. Measure a common point in the "Reference" point cloud. 
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8. Press "Validate The Picked Pair" 

                          

Figure 29: Measuring a Pair 

9. Repeat the process until you have multiple pairs measured 
10. Select the registration correction type: 
- Translation: always recommended. 
- Rotation: recommended if you can identify multiple pairs of points spread around the point cloud. 
- Scale: only for advance users. It can deform the 3D model if not applied properly. 
11. Press "Solve", the tool will calculate the values to be applied to the registration 
12. Review the registration values. 
Note: If a pair of points is not accurate enough the tool will warm the user 
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13. Press "Apply Corrections" 

                                

Figure 30: Statistics registration 

14. A new registered point cloud will be created in the table of content 

 

Figure 31: LAS Registered 
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GOOD PRACTICES 

- Use at least 3 pairs of common points for translation (minimum required is 1). 
- Use at least 6 pairs of common points for rotation (minimum required is 3). 
- Spread the measurement pairs across the point cloud, avoid measuring all the pairs of points next to 
each other. 
- In case of having multiple point clouds to register, use the most confidence point cloud as reference. 
For example: 

a) Multiple SLAM point clouds. Use the point cloud that overlaps with more point cloud as a reference. 
b) SLAM and RTK/PPK. Use the georeferenced point cloud from RTK/PPK as a reference. 
c) Drone mapping and SLAM. Use the georeferenced point cloud from drone mapping as a reference. 
d) Drone mapping and RTK/PPK. Use the georeferenced point cloud from drone mapping as a 
reference. 

LAS TO LAS AUTO REGISTRATION 

Auto registration is a tool performing fine alignment, in other words it performs an automatic 
alignment once 2 LAS are close to each other or it refines their alignment. 

Before using LAS to LAS automatic registration, ensure the reference and registered point clouds are 
initially well-aligned, with overlapping regular surfaces. 
LAS to LAS automatic registration can only be performed with point clouds with overlap surfaces areas. 

PREREQUISITES 

The tool is used to refine the alignment between two models that are relatively aligned with each other. 
This means that the tools are not able to directly align automatically two models that are apart, for 
example a SLAM and a RTK/PPK. In these cases, a pre-requisite will be required: 

Cases: 

a) SLAM to SLAM: Use LAS to LAS manual registration before performing automatic registration, at 
least to have both point clouds relatively aligned. 
b) SLAM to RTK/PPK: Use LAS to LAS manual registration before. 
c) RTK/PPK to RTK/PPK: Directly use automatic registration. 
d) SLAM to drone mapping: Use LAS to LAS manual registration before. 
e) RTK/PPK to drone mapping: Directly use automatic registration. 

HOW TO USE IT 

1. Open LAS to LAS Auto Registration tool. 
2. Select the "Reference LAS Layer" 
3. Select the "Registered LAS Layer" 
4. Press "Solve", the tool will calculate the values to be applied to the registration 
5. Review the registration values. 
Tip: review the fitness score, it means how well 2 points clouds align with each other. The "After" value 



LP360 Land Users Guide 
 

37     LP360 Land v2024.2.107.0   12/13/2024 
 

should be smaller than the "Before" value. 
6. Press "Apply Corrections" 

             

Figure 32: LAS to LAS Auto Registration 

7. A new registered point cloud will be created in the table of content 

 

Figure 33: LAS registered 

ADVANCE SETTINGS 

Search Radius: To define the area around each point that will be used to determine the morphology of 
the terrain at this point 

Min Neighbors: Minimum number of points about a point to be considered 
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Max Thickness: Maximum thickness (obtained after determining the morphology) for a point to be 
considered 

Max distance: max distance to consider a correspondence 

Max angle: max angle between normals to consider a correspondence 

Distance Type: 

- Point2Point: Euclidean distance based correspondence estimation 
- Point2PointWithAngleNormal: Euclidean distance based correspondence estimation 

considering normals of points 
- Point2Line: Point to Line based correspondence estimation 

GOOD PRACTICES 

- When registering SLAM data to georeferenced data, always perform LAS to LAS manual registration 
before. 
- It is important to have common overlap surfaces between point clouds. 
- Use the most confidence point cloud as reference. 
- Review the "Key points" and "Used Key points" after pressing "Solve", in the previous screenshot you 
can see them in "white" and "red" color. They should be consistent in all the overlap area. These points 
should be picked in flat surfaces and not in irregular features like trees. 

DIFFERENCE BETWEEN MANUAL AND AUTOMATIC REGISTRATION 

The main difference will be the quality of the alignment between the two-point clouds. Manual 
registration will perform a coarse alignment while auto registration will perform a fine alignment. 

This means that every time a LAS is manually registered, it is recommended to refine the alignment 
using the automatic registration. 

LAS TO CONTROL REGISTRATION 

Control registration is a tool performing coarse alignment, in other words it performs a rigid 
registration where the user manually aligns a LAS to Control Points. 

Before using LAS to Control manual registration, make sure that the control points are visible in the 
LAS. Translation requires a minimum of 1 Control Point, Rotation requires a minimum of 3 Control 
Points. It is recommended to perform Translation and Rotation. 

1. Import the GPS to LP360, you can use the "Import" tool from the "Control Points" ribbon 
2. Open LAS to Control Registration tool. 
3. Select the "Registered LAS Layer" 
4. Select the "Features layer" (the control points shapefile) 



LP360 Land Users Guide 
 

39     LP360 Land v2024.2.107.0   12/13/2024 
 

5. Select a control point from the list 

             

Figure 34: LAS to Control 

6. Press "Pick The Corresponding Point" 
7. Measure the point in the point cloud 
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8. Press "Validate The Picked Point" 

                    

Figure 35: Measuring a control point 

9. Repeat the process until you have multiple points measured 
10. Select the registration correction type: 
- Translation: always recommended. 
- Rotation: recommended if you can identify multiple pairs of points spread around the point cloud. 
- Scale: only for advance users. It can deform the 3D model if not applied properly. 
11. Press "Solve", the tool will calculate the values to be applied to the registration 
12. Review the registration values. 
Note: If a point is not accurate enough the tool will warm the user 
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13. Press "Apply Corrections" 

                            

Figure 36: Statistics of the registration 

14. A new registered point cloud will be created in the table of content 

 

Figure 37: Registered LAS to Control 
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SURVEY NAIL MANAGER 

The management of a priori survey base station locations (so-called “survey nail” or “reference mark”) is 

done using the Survey Nail Manager  found on the Sensor tab and is used throughout LP360 Land 
where access to these data are needed. 

 

Figure 38 - Survey Nail Manager 

 

Figure 39 - Survey Nail Manager Dialog 

Selecting Add  will invoke the Add Survey Nail dialog 

 

Figure 40 - Add Survey Nail dialog 

a) Name – Enter a unique name for the new Survey Nail 
b) Description – Optionally add a description for the new Survey Nail 
c) Survey Nail Location – Enter the Latitude and Longitude in decimal degrees or 

degrees minutes seconds (DMS) as per the selected Coordinate Format, and Ellipsoid 
height in meters. Be sure to separate the Degrees, minutes, and seconds, with a colon 
(DD:MM:SS.sssss).  
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i. If an OPUS solution is being used, save the OPUS results in a simple text file, 
and import it into LP360 using the Load from OPUS button. The Latitude, 
Longitude, and ellipsoid elevation will be automatically read from the text file 
and populated in the applicable fields.  

d) Creation Date – Enter the date when the nail was established. 
e) Frame – Choose the correct reference frame and epoch for the base station coordinate. 

The ellipsoid for the selected frame will be shown for reference. LP360 uses this 
information to perform any datum and epoch transformations necessary for 
processing. 

Selecting Clone  invokes the Clone Survey Nail dialog with an exact copy of the selected nail in 
the Survey Nail Manager dialog. Edits may then be made as desired. Note it is necessary to change the 
name to a unique name before saving the cloned nail. 

 

Figure 41 - Clone Survey Nail dialog 

Selecting Edit  will invoke the Edit Survey Nail dialog for the selected nail in the Survey Nail 
Manager dialog to make modifications as desired. 

 

Figure 42 - Edit Survey Nail dialog 

Delete, Import, Export tools are also available for managing the saved survey nail locations and moving 
them around between processing machines. 
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CONTROL POINTS PROCESSING (TVGCPS) 

It is possible to georeferenced the point cloud using control points surveyed with the TVGO during the 
scanning. 

A minimum of 4 control points are needed to properly reference a point cloud, increasing this number 
will improve point cloud alignment even further. Remember to Place the metal tip over the control 
point and click “Add control point” on the tablet. 

 

 

Figure 43: GCP measurement 

Control Points workflow: 

1. Create a .CSV file 
2. The first four comma-separated columns must be name, northing, easting, elevation in the Project 
CRS, example of the format: 
 
PP131,5654721.269,32404008.225,281.101 
PP132,5654736.233,32404010.793,281.057 
PP133,5654739.959,32404044.002,281.785 
PP134,5654737.254,32404078.968,282.121 
 
3. For a GCP to be used, the name must match the name used at collection time 
4. Copy the file at: <rawFolder>\GPS\Ctrl 
5. Import the data into LP360 LAND and continue the processing 

It is possible to check the name used during the surveying with the TVGO by opening with notepad the 
file <rawFolder>\GPS\Ctrl\ctrl.point 
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JOB MANAGER 

The LP360 Job Manager , located on the LP360 Quick Access toolbar and in the Sensor tab, is a 
convenient way to queue and manage background task processing. Typically, only one job may execute 
at any given time, but a user may queue many jobs of the same or differing types from within a project 
or across multiple projects. The processing of the queue occurs in order of submittal time on the 
machine on which the queue is created.  

SUBMITTING JOBS TO THE JOB MANAGER 

A growing list of tools, such as TVGO processing  can be submitted to the Job Manager. 

MONITORING THE JOB MANAGER 

Jobs in the Job Manager queue may be monitored by opening the Job Manager dialog (Figure 44). 
Note: The Job Manager is modeless and may be left open or closed without affecting the queue. The 

Job Manager icon will flash with a green checkmark  when one or more jobs has completed 
regardless of the currently open project in the session.  

 

Figure 44 - Job Manager dialog 

Open Project – Closes the current project in the session, prompting to save the project, and opens the 
project associated with the selected job in the grid.  

Complete Job – If the status of a job is Ready, selecting the job, then the Complete Job button will 
perform the operation shown in the Complete Job Steps column. For instance, with a “Strip Align for 
LP360” job the Complete Job will create a new LAS Layer and/or add LAS files to the specified layer in 
the project. 

Delete Job – Deletes the temporary files associated with the selected job and removes the job from the 
Job Manager. 

Cancel Job – If possible, will cancel the selected job at the next possible opportunity after being 
selected. 

Retry Job – Where applicable, the selected job can be executed again after initially being cancelled or 
experiencing a failure. 
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View Log – Where applicable, opens the default viewer with the log for the selected job. 

View Report – Where applicable, opens the default viewer with the report that was generated by the 
job. 

File Explorer – Opens in File Explorer the folder location for the selected job. 

Compute Sizes – Computes the current size on disk of the temporary files associated will all jobs in Job 
Manager. 

Show Competed Jobs – When enabled, all Completed Jobs will be visible in the Job Manager. When 
disabled, the Completed Jobs will be hidden. 

Force Parallel Execution – Allow multiple jobs to run at the same time, however it is likely jobs will 
compete for resources and conflicts may cause destabilization. Intended for advanced users who 
understand what jobs they’re running and what resource requirements are at various stages for those 
jobs.   

 

Job Manager creates a directory called “Jobs” directly under the folder in which your project xml file 
is stored (the “Project Folder”). Each submitted Job will have a unique folder under the Jobs folder. 
You can quickly access this folder by selecting the desired row in Job Manager and pressing the File 
Explorer button. Data within a Jobs directory is only used until the Job finishes. However, these 
folders are kept until you explicitly delete them using the Delete Job command. This allows you do 
still view reports, logs and so forth at some future time. Job files can consume a lot of space. The 
amount of space being taken up by a Job is listed in the Size column of the Job row in Job Manager. 

Locking your machine or closing LP360 will not affect the processing queue in Job Manager, 
however, logging out of your machine will have the unintended consequence of closing the 
background processes, including those in the Job Manager. 
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EXPORT PHOTO PACKAGE 

The Export Photo Package  on the Sensor tab will allow the user to export the photos on the 
retained layer and associated camera calibration files. This tool facilitates the downstream import of 
images into photogrammetric processing software.  

 

Figure 45 - Export Photo Package 

1. If not already done, on the Sensor tab make active the Cycle/Flight combination to be 
processed. 

2. Select Export Photo Package  on the Sensor tab to open the Update EXIF tags dialog (Figure 
46). 

 

Figure 46 - Export Photo Package dialog 

3. The Retained Photos Layer is selected based on the active Cycle/Flight on the Sensor tab.  
4. Select the desired output folder to write the geotagged images and associated camera 

calibration files.  
5. Select Export Photo Package to write the geotagged images and associated camera calibration 

files into the selected folder. 
6. A progress bar will inform you of the export progress.  
7. A confirmation dialog will appear showing the number of images and calibration files written to 

the output folder. Select OK to continue.  
8. Repeat for each Cycle/Flight combination in the project, being sure to select the same output 

folder for each so there is one photo package per project. 
 
The exported photo package contains: 

a) Images are sorted into folders by camera serial number and named with a 
Cycle_Flight_ImageNumberCameraPosition nomenclature. 

b) Camera calibration files are also placed in each camera folder. 
i. The xml files named Port_cameraserial#.xml, Starboard_cameraserial#.xml, or 

Nadir_cameraserial#.xml can be directly imported into Agisoft Metashape. 
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ii. The text files named Port_cameraserial#_P4D.txt, 
Starboard_cameraserial#_P4D.txt, or Nadir_cameraserial#_P4D.txt can be used 
in Pix4D. 

iii. For other photogrammetric packages you may need to convert these camera 
calibration values to something applicable to the respective package. For 
example, Converting Focal Length from Pixels to Millimeters to use in Bentley 
Context Capture. 

c) While Metashape and PIX4D (v4.6.4) read the updated EXIF tags, some 
photogrammetric packages require the information be read from a file: 

i. The CSV file named “Cycle_Flight_image_geo_opk.csv” contains the image 
position file in geographic coordinates, height in meters, with the orientation 
angles represented as omega, phi, kappa in degrees for each Cycle/Flight 
combination that was exported.  

ii. The CSV file named “merged_image_geo_opk.csv” is a merged file of all the 
Cycle/Flight combinations that have been exported into the same Exported 
Photo Package folder. This file is configured to be used in Pix4D. 

d) Default.prj – Contains the coordinate reference system information from the project. 
e) A DEM folder is generated for use with 3DIS® processing. 
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EXPLORER PACKAGE 

EXPORT/PUBLISH EXPLORER PACKAGE 

Export Explorer package is a tool found in Project Manager (PM) , located on the Project tab. This 
package will create an archive of the layers selected in Project Manager.  

 

Figure 47 - Project Manager - Groups/Layers 

1. Set the published name for layers as desire. 

Project Manager has a “Publish Name” column that lets you set a name that will be used as the 
new layer name when the package is imported to create a new LP360 Explorer package. This 
was added to allow you to turn Cycle layer names into something more readable. There is a 
handy tool that will automatically create short names for you. Just select the layers for 
which you want short (publish) names and press the “Set Published name …” . If you do not 
like the auto name, you can edit the fields of the row; select the row and press Edit (the 

pencil  tool at the right of the dialog) or just double-click the row. 

NOTE – Publish names of rows to be exported must be unique since these will become the layer 
names in the recreated project. 

2. Select one or more rows to select the layers that are to be included in the exported package. 
Use the usual Windows Explorer multi-select keyboard commands.  

3. Press the Export/Publish Explorer Package tool  to open the Export Explorer Package.  
4. Check the box beside Export Explorer Package to create an Explorer Package that you can 

share with a colleague or client. 
a) Set a destination path, filename for the package. The file extension is “evx”. 

5. Select “Export Explorer Package”. Confirm. The dialog will provide status as the compression 
takes place. This can take quite some time for a large project. 

a) If Export Explorer Package was selected, the data associated with the selected layer(s) 
will be packaged into a compressed archive with an extension of “evx”. This package 
can be imported by LP360 with a viewer license or higher by using the Open LP360 

Explorer Package tool . 
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OPEN AN LP360 EXPLORER PACKAGE 

To open or import an Explorer Package (a compressed “evx” package) created by the 

Export/Publish Explorer Package tool  in Project Manager , use File -> Open -> Explorer 

Package  (Figure 48), in any LP360, v2021.1.12, or later, or on the Project tab of the ribbon, to 
open the Import Explorer Package dialog . Or simply select “Import LP360 Explorer Package…” 
from the Startup dialog when you first open LP360 Land. 

 

Figure 48 - Open Explorer Package 

  

Figure 49 - Import Explorer Package dialog 

On the Input line, browse to the Explorer Package (the “evx” archive). Under Output Project Location, 
The Projects Root Folder will default to the location set in Project Settings, if set, in either case you can 
browse to the location for the top level of the LP360 project that will be created. The Project Name will 
default to the name of the Explorer Package, and can be modified at this time, if desired. After filling 
out these fields, press Import Explorer Package. The package is imported, and an LP360 project is 
created. This can take some time since the archive has to be decompressed and all file locations 
redirected. 

When the decompression and import is complete you will have a new LP360 project containing the 
layers from the package.  

Note – You cannot use this import to add layers to an existing project. If you are in an LP360 project 
when you perform an import, you will be asked if you wish to Save the current project. After the save (if 
you elect this option), a new project will be created containing the imported layers.  
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If you examine the directory structure (Figure 50) of the newly created project, you will see that it has 
been reorganized into what we might call a canonical LP360 project structure. There is a parent folder 
for the project with a set of top-level subfolders for each data type that LP360 is capable of managing:  

 LAS  
 Raster  
 Photo (True Pose® photos)  
 Feature  

 
Under each of these is a folder for each layer of that type as well as folders containing the files that are 
associated with the layer. 

 

Figure 50 - Directory structure of imported package 

Thus, one nice use of this Export tool is to collect up scattered projects. For example, if you have a 
project that accesses data from several other LP360 projects the export will collect up all the elements 
you need and deposit them into an organized, hierarchical project. 
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MULTI-CYCLE PROCESSING TIPS 

For a lot of project areas, it is necessary fly multiple Cycles to cover the project area. Follow these tips 
to help process efficiently. 

 Import all Cycles that cover the project area into the same LP360 project. 
 Use Project Manager to build Cycle and Temporal layer groups. 

o Open Project Manager . 
o Change Groups mode to Build. 

o Use  to automatically create layer Groups for each unique Cycle and Temporal date 
included in the project. 

 Use the Cycle layer groups to help move from Cycle to Cycle to process in a methodical manner 
through to colorized point clouds for 3DIS®, and updated EXIF tags for all systems. 

o Open Project Manager . 
o With Groups mode set to Use, select the desired Cycle Group from the available Groups 

in the left pane. The layer group shown in the TOC will change as you select a different 
group in Project Manager. When only one Cycle is in a layer Group, the Cycle selector 
on the Sensor tab automatically changes to match. You may leave Project Manager 
open to make it easier to change between groups, or close and re-open as needed. 

 

Figure 51 - Selected Layer Group being displayed in the TOC 

 It is typically best to QC the individual Cycle LAS layers before merging as it is easiest to correct 
or make elevation adjustments when the Cycles are separated. If using registration tools, you 
probably do not need to make any elevation adjustments to the individual Cycles but should 
still perform the QC. 

o You can do some manual comparisons of the Cycles to each other by toggling the 
active LAS layer while reviewing the profile and 3D View to compare.   

o Run a control report of each Cycle LAS layer to your check points to see if there are any 
issues such as a large offset in one of the Cycles due to mistakes in the trajectory 
processing. 

o A quick review of the attributes and coverage of each LAS layer for any issues. 
o Use the Affine Transform LAS PCT to adjust any significant elevation offsets of lines or 

Cycles to better match when they are merged. 
 

 The TOC, select the desired LAS Layers to be merged or copied, and use the right-click -> 
Merge LAS Layers command or Copy LAS Layers command to open the Merge LAS Layers 
dialog or Copy LAS Layers dialog in order to merge or copy the individual Cycle/Flight LAS 
layers into a single combined LAS layer before smoothing or ground classification. 
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Figure 52 - Merge LAS Layers RCM Command 

  

Figure 53 - Merge LAS Layers options dialog 

o For more selective processing you might select individual LAS file(s) in the LAS Files tab 
and use the right-click -> Move Selected File(s) to Layer command (Figure 54) to open 
the Move LAS Files to Layer options dialog (Figure 55). This command allows you to 
move one or more LAS files from one LAS Layer to another. You can also create a new 
destination LAS Layer with this command. 
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Figure 54 - Invoking the Move Selected File(s) to Layer Command 

  

Figure 55 - Move Selected Files to Layer command dialog 

 TVGO, if running the Smoothing Point Cloud PCT after Registration after merging/copying LAS 
Layers, select the Output Structure as “Tiled Files” to create suitable sized LAS files for 
downstream processing in LP360 such as ground classification, etc., when using QVR pyramids. 
This is not necessary when using LPLAS. 

 If not running the Smoothing Point Cloud PCT, then after merging/copying LAS Layers, use the 
Merge Point Cloud PCT to create suitable sized LAS files for downstream processing in LP360 
such as ground classification, etc. Files should be no larger than 256MB on disk for optimal 
performance when using QVR pyramids. This is not necessary when using LPLAS. 

 If you wish to subset RetainedPhotos layer(s), select the desired layer(s) in the TOC and use the 
right-click Merge Feature Layers and/or Copy Feature Layer command, as applicable, to 
create an editable copy that is easy to delete and re-create if needed.  
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Figure 56 - Merge Feature Layers command dialog 

 Create a single photo package for all Cycle/Flight RetainedPhotos layers by always selecting the 

same output folder for the Export Photo Package  tool as you toggle between each 
applicable Cycle/Flight combination. 

o If your project area is very large and has a lot of photos, then you may need to section it 
into overlapping sub areas depending on the capabilities of your photogrammetric 
software and the capabilities of your hardware. 
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SUPPORT 

Our searchable support knowledge base contains information on workflows, tips, hints, and probable 
resolutions to error messages or commonly encountered situations. 

https://support.geocue.com/ 

Normal support business hours are Monday - Friday, 8 AM — 5 PM USA Central Time. 

If a support request is sent during business hours a representative will typically get back to you within 4 
hours. If received after hours, a response will be sent the following day. To speed response time please 
include the following information in your request: 

 Contact information - please include e-mail address and phone number 
 Account name 
 TrueView Model and Serial Number 
 TrueView Cycle log 

If your request includes problems pertaining to a specific error message, please include a screenshot of 
the error message. 

TrueView Cycles may be easily transferred to support by first moving/copying them to your LP360 
Cloud Cycle-Archive (see TrueView Archive Manager). Then, log into your LP360 Cloud account, select 
the Cycle-Archive folder, locate the desired archived Cycle(s) and select share with everyone to 
generate a link that you can share with us in your support ticket.  

For all other data types, use the Upload to Support  tool found on the Support tab in LP360 to 
browse for a folder and have LP360 compress the contents of the selected folder and any subfolders, 
with an option to exclude JPG images when not needed for the support ticket, and upload the 
compressed folder to the Support folder of your LP360 Cloud account. Then, log into your LP360 Cloud 
account, locate Support folder, then the desired layer(s) and select share with everyone to generate a 
link that you can share with us in your support ticket. 

 

Figure 57: Upload To Support dialog 

For LP360 Land and TrueView hardware support contact: support@geocue.com 


